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Introduction 
 
For a number of years, the authors have been using various software products to develop 
classroom demonstrations for use in teaching calculus, including Derive, The Geometer’s 
Sketchpad®, and the TI-NspireTM CAS Computer Software.  Most recently, however, we 
have turned to GeoGebra as our software of choice for creating dynamic classroom 
calculus demos, for a variety of reasons.  Among these reasons are the following: 
 

• As its name suggests, GeoGebra is designed around a tight connection between 
the algebraic and geometric representations of mathematical objects.  For 
instance, a function in GeoGebra is at once an algebraic object and a geometric 
one, and can therefore be manipulated in either way.  This connection helps to 
make GeoGebra an ideal environment for exploring concepts of calculus. 

• GeoGebra makes it trivial to create both stand-alone Java applets and simple web 
pages with embedded applets.  Since any interactive demos that you create can 
easily be placed on the web, you can provide your students with free, readily 
available access to those demos for continued exploration outside of class. 

• GeoGebra is compact and portable.  Written in Java, it will run on a variety of 
machines.  It is also small in size, and can easily be installed on a USB flash 
memory drive, to run virtually anywhere. 

• GeoGebra is free!  Distributed by its international development team under the 
GNU General Public License, GeoGebra will cost you nothing to use or even to 
install on every computer on campus!  But remember that your students will not 
need GeoGebra to interact with the GeoGebra applets you create; they will need 
only the most common of today’s computer tools: an internet connection and 
Java.  To get started with GeoGebra, visit the GeoGebra web site, at 
http://www.geogebra.org. 

 
In this paper we give step-by-step instructions for creating several interactive calculus 
demos.  We hope these inspire you to create some of your own. 
 
 
 
 



Graphing the Definite Integral Function  
 
In this demonstration, we begin with the graph of a function f, and compute values of the 
function ( ) ( )

x

a
g x f t dt= ∫ , graphing this new function.  Students can then be prompted to 

recognize the shape of the graph of ( )g x′ , thereby discovering the First Fundamental 
Theorem of Calculus, that ( ) ( ).g x f x′ =  Here are the steps we use to create this 
demonstration. 

• On a new GeoGebra page, create a function, such as 
3 2

( ) 2.
4 2
x xf x x= − − +  Do 

this by typing f(x)=x^3/4–x^2/2–x+2 in the Input Bar, at the bottom left. 
• Enter a=0 in the Input Bar.  (This will be the lower limit in the integral.) 
• Click the Slider button       and then click in the “Graphics View” (the drawing 

space) to create a slider for the upper limit of the integral, b.  In the slider dialog 
box, change the name to b, the interval to [ 4,6]− , and the increment to 0.01.  In 
the slider tab of the dialog box, change the width of the slider to 300 pixels. 

• Click the Move button       , and then drag the slider to a convenient location in the 
drawing space. 

• In the Input Bar, type Integral=Integral[f,a,b], to compute the value 
of the integral function and automatically shade the relevant region on the graph 
of f. 

• Click the Move button      .  Notice that you can drag the point b on the slider, to 
change the upper limit of the integral.  Drag b on the slider, to change its value to 
approximately 3.3− . 

• In the Input Bar, type C=(b,Integral), to plot a point on the graph of the 
integral function, g. 

• Right-click on C (either in the Graphics View, or in the “Algebra View” in the 
pane on the left side), and select Trace On in the pull-down menu.  Optionally, 
after right-clicking, select Object Properties, which will bring up a dialog box in 
which you can change the color and size of the plotted point. 

• Be sure that you have selected the Move tool, and drag the point b on the slider, to 
graph the integral function.  If wish, you can select the point b by clicking it, and 
then move it along the slider by using the cursor arrow keys.  Since you have set 
the increment for b to 0.01, this method will assure that the graph is fully formed.   

• You can now prompt your students to see that if the new function were 
differentiated graphically, the derivative would be f, the integrand function. 

• To repeat the demonstration, simply drag the value of b back to around 3.3− , and 
select Refresh Views under the View menu.  If you wish to change the function, 
right-click on the function (either in the Graphics View or in the Algebra View), 
select Properties, and type in a new formula.  The value of a, the lower limit of 
the integral, can be changed in a similar way. 

 
Figure 1 shows a GeoGebra worksheet in the process of constructing the graph of the 
integral function. 



 
 

Figure 1. 
The Graph of the Definite Integral Function. 

 
 
 

Riemann Sums 
 
Although several Riemann sum demonstrations can be found on the web, it is easy and 
fun to create your own, using GeoGebra. At the same time, you can build in more 
generality than can be found in most existing demos.  Here are the steps: 
 

• On a new GeoGebra page, create a function, such as 
3 2

( ) 2.
4 2
x xf x x= − − +  Do 

this by typing f(x)=x^3/4–x^2/2–x+2 in the Input Bar, at the bottom left. 
• Click the slider button      , and create a slider for a, the left endpoint of the 

interval over which you wish to build the Riemann sums.  You could let a vary 
from 5−  to 5 in increments of 0.1.  The default slider width of 100 pixels should 
be sufficient. 



• Create a similar slider for b, the right endpoint of the interval. 
• Create a similar slider for a variable called “Position,” which specifies the relative 

location of the points in each subinterval, which will be used in the construction 
of the Riemann sums.  Vary Position from 0 to 1 in increments of 0.1. 

• Create a slider for n, the number of subintervals for the Riemann sum.  This slider 
could vary n from 1 to 100 in increments of 1.  A width of 300 pixels should work 
well. 

• Select the Move tool    , and drag the sliders to convenient locations in the 
Graphics View. 
 

 
Figure 2. 

A Riemann Sum using 6n = and Midpoints of Subintervals. 
 
 
 

• In the Input Bar, type the formula for xΔ in the Riemann sum:  dx=(b-a)/n . 
• Next we create the *

ix  points in the subintervals, at which the function will be 
evaluated.  In the Input Bar, enter  



xpts = Sequence[a + (Position + i) dx, i, 0, n - 1] 
 

 This command creates a sequence of n numbers, one from each of the n 
subintervals of [ , ]a b .  The locations of these numbers are determined by the 
value of the Position variable.  When the Position slider is set to 0, the numbers 
xpts are the left endpoints of each subinterval; when Position = 1, they are the 
right endpoints; and when Position = 0.5, they are the midpoints. 

• Next we create the corresponding sequence of function values to use in the 
Riemann sum, by entering the command fxpts=f(xpts) in the Input Bar. 

• Finally, the Riemann sum is created by entering the following command in the 
Input Bar: 

RiemannSum = BarChart[a,b,fxpts] 
 This will automatically shade the region corresponding to the Riemann sum, as 

well as display the value of the Riemann sum. 
• If you wish, you can right-click any of the visible objects, and change their 

properties such as color.  Also, the sliders can be moved to suitable locations so 
that they do not interfere with the graph or the Riemann sum. 

• If you wish, you can add text near the sliders, to explain briefly what the sliders 
are used for.  (See Figure 2.)  To do this, click the small arrow in the lower right 
corner of the slider button, and select        from the pull-down menu.  Then simply 
click in the Graphics View and enter the appropriate text.  You can change the 
color, size and font by right-clicking the text and selecting Properties. 

 
 
Catenary Illustration 
 
A common application of the hyperbolic cosine function is to model the shape of a freely 
hanging heavy cable or chain, suspended on both ends at equal heights, called a catenary.  
While virtually every calculus book written in the last four decades cites the example of 
the Gateway Arch in St. Louis as an inverted catenary, it is difficult to model the Arch 
with a photograph, because the extreme angle of the photograph will alter the perspective 
of the curve.  However, catenary curves are abundant in everyday life, and some of them 
can be very easily modeled using GeoGebra. 
 
Figure 3 shows a GeoGebra window into which a photograph has been inserted, showing 
a hanging chain at the Rock and Roll Hall of Fame in Cleveland.  Any similar digital 
photo of a hanging cable or chain could be used instead.  In the steps below, we show 
how to model the curve formed by the chain.  Since the chain should follow the curve 

( ) cosh xf x c a
a

⎛ ⎞= + ⎜ ⎟
⎝ ⎠

, there are only two parameters that need to be represented by 

sliders, and it should be possible to adjust those sliders to make the curve fit the chain in 
the photo. 
 



 
 

Figure 3. 
Fitting a Catenary to a Hanging Chain. 

 
• Click the arrow in the lower right corner of the Slider button, and select Insert 

Image     .  Click in the Graphics View to begin the process of importing your 
photo.  (You will probably have to resize and/or crop your photo ahead of time, as 
it will match your monitor resolution pixel-for-pixel when it is imported.  In 
Figure 3, we cropped and resized the photo so that it was 800 pixels across—and 
even then, most of the photo is not showing in the GeoGebra window.) 

• After specifying the location of your photo on disk, the picture should appear in 
the GeoGebra Graphics View.  Select the Move button, and drag your photo so 
that the bottom just barely sits on top of the x-axis, and the hanging cable or chain 
is clearly visible, with its lowest point directly above 0 on the x-axis.  You can 
also resize the GeoGebra window to get additional cropping. 



• Insert sliders for the parameters a and c that are needed by the function.  In Figure 
3, both sliders range from 10−  to 10 in increments of 0.05.   

• Enter the formula for the function in the Input Bar:  
f(x) = c + a cosh(x/a) . 

Depending on the background of your photo, you may wish to change the color 
and thickness of the graph and its label.  Be sure to leave a space between “a” and 
“cosh” in your formula, or use ∗  to indicate the multiplication. 

• Dragging the sliders should now make it possible to make the curve fit the 
hanging chain very well, demonstrating that the shape is indeed that of the 
function f. 

 
 
Creating Applets for the Web 
 
Before saving a GeoGebra worksheet as a web page, adjust the format to what you want 
the students to see.  For example, you might want to use the View menu to hide the 
algebra portion of the worksheet.  Use the Tools menu to customize the toolbar, giving 
students only the tools they need for that particular activity.  Finally, resize the window to 
the desired size of the applet that will be embedded in the web page.  If you create a web 
page using a full screen GeoGebra worksheet, students will have to scroll to see parts of 
it in the resulting web page. 
 
Once the worksheet has the desired format, follow these steps to create a web page 
containing the GeoGebra worksheet as and applet. 
 

• Choose Export ... Dynamic Worksheet from the File menu.   
• Type a title for the web page in the Title field, and type directions and 

explanations in the fields for Text above and below the construction.   
• Check the radio button for Dynamic worksheet to have the applet automatically 

load at the same time as the web page.   
• Click the Advanced Tab, and select the desired features under Functionality and 

User Interface. 
• There are a number of supporting files that are necessary to make the applet work 

properly.  In the Files section of the Advanced Tab, check “ggb Files & jar Files” 
to create these files locally; leave this unchecked to direct the user’s browser to 
get these files from the GeoGebra site. 

• Click “Export.” 
• Since there will be at least two files associated with the web page, it’s best to save 

each web page to its own directory.  When you click Save, all of the necessary 
files will be created and saved to the same directory. 

• Use an html editor if necessary to format and/or change the text on the web page. 
• Put the directory containing the html document and the supporting files on your 

web server. 
 



Conclusion 
 
As the examples in this paper show, the ease and versatility of GeoGebra make it an ideal 
tool for creating dynamic worksheets for both classroom demonstration and student 
exploration.  The close connection between the algebraic and geometric representations 
of mathematical objects, which is inherent in GeoGebra, helps students visualize 
concepts from algebra and calculus from multiple perspectives.  Moreover, since it is 
straightforward to make dynamic Java applets available on the web with GeoGebra, 
students can continue interacting with mathematical concepts beyond the classroom.   
 
For additional examples and further information, we invite you to visit our web site, at 
http://www.jcu.edu/math/ICTCM2010. 
 
 
 


